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Welcome to FontGroups' Help.

From this page you can get Help on how to use FontGroups.

Click on a button to make your choice.
          What is FontGroups?  
          The FontGroups window  
          How To...  
          Menus  
          Keyboard shortcuts  
          About IMSI  

To choose a Help topic...

Point to your choice and click.

Use Tab or Shift Tab to highlight your choice, then press Return.

For more information about using this Help, select How to Use Help from the Help menu. 



What is FontGroups?

FontGroups is a powerful utility that helps you organize your fonts into groups. You can use FontGroups 
to preview all your fonts and then build a structure that makes sense to you. 

If you work with many fonts, as most Windows users do, you will find it easier to keep track of your fonts 
if you maintain a logical and orderly group structure. For example, you might store all your fancy fonts in 
one group, and plain fonts in another group, or perhaps you'd prefer to organize them document by 
document, e.g. all the fonts you use to create newsletters in one group, and those that you use to create 
reports in another group.    The possibilities are endless!

The font groups that you create will only be recognized by applications that have been supplied 
by IMSI. specifically for use with them.



The FontGroups window

Click on an area of the FontGroups window below to popup a description of the selected area.



    Control-menu box

Click on this box to display the FontGroups Control menu.    By using Control menu commands, you 
can restore, move, minimize, and close FontGroups, and switch to other applications. 

When using a mouse, you can perform these tasks by clicking and dragging.

Keyboard shortcut:

Alt Spacebar displays the Control menu.



Title bar

Displays the name of the application, i.e. FontGroups.
To move FontGroups to a different location on your desktop, drag its title bar to the new location.



    Minimize button

An alternate to selecting Minimize from the FontGroups Control menu. Click on the Minimize button to 
reduce FontGroups to an icon.

When you reduce FontGroups to an icon, it continues to run but does not take up space on your 
desktop.

To restore FontGroups to its previous size, either double-click on its icon, or click on its icon and 
select Restore from the Control menu that has appeared.



Menu bar

Displays the menus available to FontGroups: File, Group, and Help. Click on a menu name to drop-
down a list of corresponding menu commands.



Font Groups list box

Displays the structure of your font groups. When a font group contains sub-groups, its icon is marked 
with a plus sign (+). The plus sign means that you can expand the font group to display its sub-groups. 

Double-click on a font group to expand it; double-click again to collapse it. 

Click on a font group or sub-group to select it.
You need to select a group when you want to add fonts to it, remove fonts from it, rename it, 

expand it, collapse it, or delete it.
When a group is selected, its name and icon are highlighted in the list box.
If there are more font groups than can fit in the list box, a vertical scroll bar is provided so you can 

move through the list.    Use this scroll bar to view font groups that are beyond the borders of the box.
You can only select one font group at a time.



An alternate to selecting Create from the Group menu. Click on the Create button to display the Create 
Group dialog box. 

Enter a name for your new font group, then click on OK. The new font group is created and its name will 
appear in the Font Groups list box.

If you want to create a sub-group, select the font group in which you want the sub-group to 
appear, then proceed as above.



An alternate to selecting Rename from the Group menu. Click on the Rename button to display the 
Rename Group dialog box.

Enter the new name for the selected font group, then click on OK. The font group is renamed and its 
new name will appear in the Font Groups list box.



An alternate to selecting Delete from the Group menu. Click on the Delete button to delete the selected 
font group.

A message will appear asking you to confirm that you want to delete the selected group. Click on Yes or 
No as appropriate.

If you delete a font group that contains sub-groups, the sub-groups will also be deleted.



Fonts In Current Group list box

Displays all the fonts in the selected font group. Click on a font to select it.

To select several fonts at once, Shift-click to select the fonts in sequence, Ctrl-click to select the fonts 
out of sequence.

You need to select a font when you want to remove it from the selected font group, or preview it in 
the Sample window. When you have several fonts selected, only the last font on which you clicked is 
previewed in the Sample window.

When a font is selected, its name is highlighted in the list box.
Use the vertical scroll bar to the right of the list box to view all of the fonts.



Fonts Available list box

Displays all the fonts available to your default printer. Click on a font to select it.

To select several fonts at once, Shift-click to select the fonts in sequence, Ctrl-click to select the fonts 
out of sequence.

You need to select a font when you want to add it to the selected font group, or preview it in the 
Sample window. When you have several fonts selected, only the last font on which you clicked is 
previewed in the Sample window.

When a font is selected, its name is highlighted in the list box.
Use the vertical scroll bar to the right of the list box to view all of the fonts.



Click on this button to remove all the fonts that are selected in the Fonts In Current Group list box from 
the selected font group.



Click on this button to add all the fonts that are selected in the Fonts Available list box to the selected 
font group.



Sample window

Previews the last font on which you clicked in either the Fonts In Current Group list box, or the Fonts 
Available list box.



Info line

Displays hints on what to do next.



How To...

Click on a button for Help with using FontGroups.
          Select a font group  
          Collapse a font group  

            Expand a font group  
            Create a new font group  
            Add fonts to a font group  
            Remove fonts from a font group  
            Rename a font group  
            Delete a font group  
            Save your changes  
            Abandon your changes  
            Exit FontGroups  



Selecting a font group

You need to select a font group when you want to add fonts to it, remove fonts from it, rename it, expand 
it, collapse it, or delete it.

How to select a font group

In the Font Groups list box, click on the group name that you want to select.
When a font group is selected, its name and icon are highlighted in the list box, e.g.:

If there are more font groups than can fit in the Font Groups list box, a vertical scroll bar is 
provided so you can move through the list.    Use this scroll bar to view font groups that are beyond the 
borders of the box.

You can only select one font group at a time.



See also:
            How to expand a font group  
            How to collapse a font group  
            How to add fonts to a font group  
            How to remove fonts from a font group  
            How to rename a font group  
            How to delete a font group  
            Keyboard shortcuts  



Collapsing a font group

When you start FontGroups, the Font Groups list box displays all the font groups and sub groups that 
have been created. You can collapse a font group so that its sub-groups do not appear.

How to collapse a font group

Double-click on the group icon or the name of the group that you want to collapse. The group is 
collapsed and its sub-groups are hidden in the Font Groups list box, e.g.:

If there are more font groups than can fit in the Font Groups list box, a vertical scroll bar is 
provided so you can move through the list.    Use this scroll bar to view font groups that are beyond the 
borders of the box.

You can collapse all the font groups at once by double-clicking on the icon at the top of the list.

Keyboard alternate:

Select the group that you want to collapse, then press the Minus (-) key.



See also:
            How to select a font group  
            How to expand a font group  



Expanding a font group

You can expand a font group so that its sub groups will appear in the Font Groups list box. A plus sign 
(+) marks each group icon that has sub-groups, indicating that the group can be expanded. 

How to expand a font group

Double-click on the group icon or the name of the group that you want to expand. The group is 
expanded and its sub-groups will appear in the Font Groups list box, e.g.:

If there are more font groups than can fit in the Font Groups list box, a vertical scroll bar is 
provided so you can move through the list.    Use this scroll bar to view font groups that are beyond the 
borders of the box.

Keyboard alternate:

Select the group that you want to expand, then press the Plus (+) key.



See also:
            How to select a font group  
            How to collapse a font group  



Creating a new font group

You can create a new font group or sub-group using the Create command. When you have created a 
new group, you can add fonts to it from the Fonts Available list box. 

How to create a new font group

1. From the Font Groups list box, select one of the following:
to create a new font group, select the icon at the top of the list
to create a new sub-group, select the font group in which you want the sub-group to appear.

2. From the Group menu, select Create, or click on the Create button in the Font Groups group box. 
The Create Group dialog box will appear.

3. In the Group Name box, enter a name for the new group, e.g.:

 

4. Click on OK.

The new group is created and its name will appear in the Font Groups list box.
You cannot give two groups the same name. If you enter a name that already exists, FontGroups 

will inform you that each name must be unique.



See also:
            Create Group   dialog box   
            How to select a font group  
            How to add fonts to a font group  
            How to remove fonts from a font group  



Adding fonts to a font group

You can add fonts to a font group by selecting them from the Fonts Available list box.

How to add fonts to a font group

1. From the Font Groups list box, select the font group to which you want to add fonts.

2. From the Fonts Available list box, select the font(s) that you want to add.

To select several fonts at once, Shift-click to select the fonts in sequence, Ctrl-click to select the 
fonts out of sequence.

3. Click on the Add to Group button in the Fonts group box.

The selected fonts are added to the selected font group and will appear in the Fonts In Current Group 
list box.

When a font is selected, its name and icon are highlighted in the list box, and it is previewed in 
the Sample window.

If there are more fonts than can fit in the Fonts Available list box, a vertical scroll bar is provided 
so you can move through the list.    Use this scroll bar to view fonts that are beyond the borders of the 
box.

You can add the same font to more than one font group.



See also:
            How to select a font group  
            How to remove fonts from a font group  
            Keyboard shortcuts  



Removing fonts from a font group

You can remove fonts from a font group by selecting them from the Fonts In Current Group list box.

How to remove fonts from a font group

1. From the Font Groups list box, select the font group from which you want to remove fonts.

2. From the Fonts In Current Group list box, select the font(s) that you want to remove.

To select several fonts at once, Shift-click to select the fonts in sequence, Ctrl-click to select the 
fonts out of sequence.

3. Click on the Remove from Group button in the Fonts group box.

The selected fonts are removed from the selected font group and no longer appear in the Fonts In 
Current Group list box.

When a font is selected, its name and icon are highlighted in the list box, and it is previewed in 
the Sample window.

If there are more fonts than can fit in the Fonts In Current Group list box, a vertical scroll bar is 
provided so you can move through the list.    Use this scroll bar to view fonts that are beyond the borders 
of the box.

Removing fonts from a font group does not delete them from your Windows setup.



See also:
            How to select a font group  
            How to add fonts to a font group  
            Keyboard shortcuts  



Renaming a font group

You can rename a font group using the Rename command.

How to rename a font group

1. From the Font Groups list box, select the font group that you want to rename.

2. From the Group menu, select Rename, or click on the Rename button in the Font Groups group 
box. The Rename Group dialog box will appear.

3. In the Group Name box, enter a new name for the selected group, e.g.:

4. Click on OK.

The font group is renamed and its new name will appear in the Font Groups list box.
You cannot give two groups the same name. If you enter a name that already exists, FontGroups 

will inform you that each name must be unique.



See also:
            Rename Group   dialog box  
            How to select a font group  



Deleting a font group

You can delete a font group using the Delete command.

How to delete a font group

1. From the Font Groups list box, select the font group that you want to delete.

2. From the Group menu, select Delete, or click on the Delete button in the Font Groups group box. 
A message will appear asking you to confirm the deletion.

3. Click on Yes to delete the group.

The font group is deleted and is removed from the Font Groups list box.
If you delete a group that contains sub groups, the sub-groups will also be deleted. FontGroups 

will display a message to warn you of this.
Deleting a font group does not remove the fonts contained within from your Windows setup.



See also:
            How to select a font group  



Saving your changes

Saving your changes makes a permanent record of your font groups on disk. None of the changes you 
make to your font groups are recorded on disk until you save them. It is sensible to save your font 
groups regularly.

How to save your changes

Select Save from the File menu. The font groups are saved to disk and FontGroups remains open for 
editing.



Abandoning your changes

As you edit your font groups you will inevitably want to abandon some changes that you make. You can 
abandon all the changes that you have made to your font groups since you last saved them.

How to abandon your changes

1. Select Abandon Changes from the File menu. A message will appear asking you to confirm that 
you want to abandon your changes.

2. Click on Yes to abandon all the changes you have made to your font groups since you last saved 
them.



Exiting FontGroups

When you have finished your FontGroups session you can exit.

How to exit FontGroups

Do any of the following:
Select Exit FontGroups from the File menu.
Select Close from the FontGroups Control menu.
Double-click on the FontGroups Control-menu box.

FontGroups is removed from your screen.
If the font groups have any unsaved changes, a message will appear asking if you want to save 

the changes before you exit. Click on Yes to save the changes, click on No to discard them.

Keyboard shortcut:

Alt F4



Menus

There are three menus in the FontGroups menu bar. Click on one of the options below to view the 
corresponding menu.
            File menu  
            Group menu  
            Help menu  



File menu

Click on the menu command for which you want Help.



Save

Saves your font groups to disk.



Abandon Changes

Abandons all the changes that you have made to your font groups since you last saved them.

A message will appear giving you the chance to cancel this command.



Exit FontGroups

Exits FontGroups. If the font groups contain any unsaved changes, a message will appear giving you 
the opportunity to save or abandon the changes. 



Group menu

Click on the menu command for which you want Help.



See also:
            Create Group   dialog box  
            Rename Group   dialog box   



Create

Displays the Create Group dialog box. 

Enter a name for the new font group, then click on OK. The new font group is created and its name will 
appear in the Font Groups list box.

An alternate to clicking on the Create button in the Font Groups group box. 



Rename

Displays the Rename Group dialog box. 

Enter a new name for the selected font group, then click on OK. The font group is renamed and its new 
name will appear in the Font Groups list box.

An alternate to clicking on the Rename button in the Font Groups group box. 



Delete

Deletes the selected font group.

A message will appear giving you the chance to cancel this command.
If you delete a font group that contains sub-groups, the sub-groups will also be deleted.
An alternate to clicking on the Delete button in the Font Groups group box. 



Help menu

Click on the menu command for which you want Help.



Contents

Displays the contents page of the FontGroups Help.

From the contents page you can select the area on which you want help.



Search for Help on

Displays the Search dialog box.

From this dialog box you can search for and select the specific subject on which you want help. It is 
similar to using the index of a book to look up a subject on which you want information.



How to Use Help

Displays information about using the FontGroups Help and teaches you how to navigate your way 
around the Help information available.



About FontGroups

Displays the FontGroups billboard. This shows the version number of your copy of FontGroups and a 
copyright notice.



Keyboard equivalents and shortcuts

If you are familiar with Windows, you will already know that there are many keyboard equivalents to 
using the mouse.

FontGroups provides its own additional equivalnts and shortcuts, and these are listed below.

Selecting, collapsing and expanding a font group

Press Tab to move the selection cursor to the Font Groups list box, then use one of the following key 
sequences:

Press To

 ¯ Select the group above or below the current group.

Home Select the first group in the list.

End Select the last group in the list.

PgUp Select the group one window up from the current group.

PgDn Select the group one window down from the current group.

Plus (+) Expand the selected font group.

Minus (-) Collapse the selected font group.

Selecting fonts

Press Tab to move the selection cursor to the Fonts Available list box, or the Fonts In Current Group 
list box, then use one of the following key sequences:

Press To 

 ¯ Select the font above or below the current font.

Home Select the first font in the list.

End Select the last font in the list.

PgUp Select the font one window up from the current font.

PgDn Select the font one window down from the current font.

A letter Select the next font that begins with that letter.

To select two or more fonts in sequence, use the  ¯ keys to move to the first font that you want to select. 
Press and hold down Shift while you use the  ¯ keys to select the remaining fonts. 

To select two or more fonts out of sequence, use the  ¯ keys to move to the first font that you want to 
select, then press and release Shift F8. The selection cursor begins to blink. Use the  ¯ keys to move 
to each remaining font you want to select, then press the Spacebar to select each font. Press Shift F8 
when you finish selecting fonts. 

Menu command shortcuts

Press To 

F10 Pass control to the menu bar.

F1 Open the Help.

Alt Spacebar Display the Control menu.

Alt F4 Exit FontGroups.



IMSI Software
for Home and Small Business

Presidents Letter.-

IMSIs goal is to provide you with the highest quality software products at affordable prices.    Since 1983, 
millions of our award-winning products have been purchased throughout the world.    This catalog 
presents our most popular titles.    Most are Windows 95 compatible.    Some of these products are on 
the CD you have just purchased, and can be accessed by simply calling us!    Other products can be 
tried for FREE by downloading them from our Internet WEB site.    We invite you to try them and enjoy 
them.

Sincerely,

Martin Sacks, CEO and President

Instant Access to IMSI Products via CD Unlocking & Internet Downloading:

You may find several other IMSI software products on your CD!    These products can be unlocked by a 
simple phone call to us to purchase your special access code.    Check your CD today! Some IMSI 
software can also be downloaded for FREE on the Internet at http:\\www.imsisoft.com.

Two Special Offers to Our Customers!

A 25% discount off the retail price for any purchase directly from IMSI of any products in this catalog. 

And a FREE -MasterClips 1000 (award-winning color clip art - $19.95 value) with every order!

Where to Find Information 

Internet WEB Site http:\\www.imsisoft.com

CompuServe GO IMSI, GO TURBOCAD, GO FORMTOOL

FAX INFO 415-257-3000 ext. 4

Technical support 415-257-3000 ext. 3
support@imsisoft.com

Sales Orders 800-833-8082 

FAX 415-257-3565

Bulletin Board 415-257-8468 N-8-1

GST Technology Ltd is a worldwide software developer at the leading edge of user interface design for 
desktop publishing and graphics technology under Windows.    GST is the author of FontGroups, 
developed specifically for IMSI and licensed to them.

GST has a range of other products in the desktop publishing and graphics fields sold worldwide by a 
variety of licensees.

GST contacts are:

Europe

GST Technology Ltd, Meadow Lane, St. Ives, Huntingdon, Cambridgeshire, PE17 4LG, UK.
Telephone: +44 (0)1480 496789
Fax: +44 (0)1480 496189
Email: postmaster@gst-soft.demon.co.uk

USA

GST USA representative office, PO Box 5224, Englewood, CO 80155-5224, USA.
Telephone: +001 (303) 680 9121



Fax: +001 (303) 680 5611

Copyright © 1995 GST Technology Limited.



Create Group dialog box

This dialog box will appear when you select Create from the Group menu, or when you click on the 
Create button in the Font Groups group box.

From this dialog box you can create a new font group.

Create Group box:

Enter a name for the new font group in this box. The name must be no more than 31 characters.

When you click on OK the new font group is created and its name is listed in the Font Groups list box.
You cannot give two groups the same name. If you enter a name that already exists, FontGroups 

will inform you that each name must be unique.



See also:
            How to create a new font group  



Rename Group dialog box

This dialog box will appear when you select Rename from the Group menu, or when you click on the 
Rename button in the Font Groups group box

From this dialog box you can rename a selected font group.

Rename Group box:

Displays the current name of the selected group. Enter a new name for the group in this box. The name 
must be no more than 31 characters.

When you click on OK the selected font group is renamed and its new name is listed in the Font 
Groups list box.

You cannot give two groups the same name. If you enter a name that already exists, FontGroups 
will inform you that each name must be unique.



See also:
            How to rename a font group  



The FontGroups file GSTFONTS.INI is read only. Aborting...

The FontGroups file GSTFONTS.INI is read only. You would not be able to make any changes. The file 
may be read only because it is on a network , or because you have set it to read only by mistake.

If you have the appropriate rights to the file, you can change it from being read only by using the 
Windows File Manager (using the Properties command in the File menu).

For full details of the Properties command, refer to your Microsoft Windows User's Guide.



Unable to create backup of GSTFONTS.INI. Aborting...

When FontGroups starts up, it creates a backup file of GSTFONTS.INI called GSTFONTS.GST. At the 
moment it is not possible to create this backup.

To resolve this problem, exit FontGroups, then check your available disk space, check that you have not 
write protected your disk or the backup file and that you have access rights to the path where it is kept.



You have reached the Group line length limit.

You have reached an internal program limit to the number of groups that can be created within a font 
group. To resolve this problem try using a shorter group name, or start a new parent group.



The font group name 'Top' is reserved for use by the program. Please choose 
another name.

You have tried to give a font group the name 'Top'. This font group name is reserved for use by 
FontGroups.

Try again with a different name.



Illegal character in font group name.

The name that you have entered contains one or more of the following characters: = [ ] \ or ,

Enter a different name that does not contain any of these characters.



The font group name 'Others' is reserved for use by the program. Please 
choose another name.

You have tried to give a font group the name 'Others'. This font group name is reserved for use by 
FontGroups.

Try again with a different name.



Font group names must be unique.

You have tried to give a font group a name that you've already used. You cannot give two font groups 
the same name.

Try again with a different name.



You must give this font group a name.

You must name all font groups.

Enter a name for the font group before clicking on OK.



This font group has sub-groups. Do you really want to delete it?

When you delete a font group, all sub groups within the font group are also deleted. Do you want to 
delete the font group?

Click on Yes to delete the font group and all its associated sub-groups; click on No to cancel the 
deletion.



Do you really want to delete this font group?

Do you want to delete the selected font group?

Click on Yes to delete the font group; click on No to cancel the deletion.



Save changes to your font groups?

Do you want to save the changes you have made to your font groups? 

Click on Yes to save the changes; click on No to abandon them.



Abandon changes to your font groups?

Do you want to abandon the changes you have made to your font groups?

Click on Yes to abandon the changes; click on No to cancel the command.



No default printer selected. Use the Windows Control Panel to select one and 
then try again.

FontGroups has been unable to find a printer in your Windows setup. You must have a default printer 
selected so that FontGroups knows which screen fonts have matching printer fonts.    Using the 
Windows Control Panel, check that you have installed at least one printer and that one is setup as the 
default printer. When you have setup a default printer, try running the program again.

For full details of the Windows Control Panel, refer to your Microsoft Windows User's Guide.



Glossary definitions:



Menu

A list of commands that drop-down from the menu bar. The menu bar will appear below the title bar and 
lists the menu names, i.e. File, Group and Help. You can open a menu by selecting the menu name.



Font

This is used in FontGroups to mean the style of type, e.g. Arial or Times New Roman. Elsewhere this 
may be called a typeface, with the term font reserved for a particular weight, size and style of typeface.



Preview

A display of sample characters styled in the selected font. The characters are previewed in the Sample 
window.



Font group

A collection of fonts that are somehow related. For example, fancy fonts such as Concerto, Ornamental 
and Splendid could be stored together in one font group, while plain fonts such as Arial, Times New 
Roman and Courier could be stored together in another font group.

You can build font groups in any structure that makes sense to you, and you can put the same font in 
more than one group. 



Restore

To return FontGroups to its previous size. You will need to 'restore' Fonts Groups when you have 
minimized it to an icon. Either double-click on the icon, or click on the icon and select Restore from the 
Control menu that will appear.



Minimize

To reduce FontGroups to an icon. FontGroups continues to run, but does not take up space on your 
desktop. Either click on the Minimize button, or click on the Control-menu box and select Minimize from 
the Control menu that is displayed.



Icon

A graphical representation of various elements of FontGroups, e.g.

Represents a font group.

Represents a font group that can be expanded.

Represents FontGroups when in Program Manager, or when it is minimized.



Sub-group

A font group within another font group. For example, you could have a font group called Plain, that 
contained two sub-groups: Sans and Serif.



Expand

To show hidden sub-groups. When a font group contains hidden sub-groups its icon is marked with a 
plus sign (+), i.e. 



Collapse

To 'hide' the sub-groups in a selected font group.



Scroll bar

A bar that appears at the right edge of a list box whose contents are not entirely visible. Scroll up and 
down to move through the items that do not fit in the list box.



Highlighted

Indicates that a font group or font is selected and will be affected by your next action. Highlighted 
objects change color and are surrounded by the selection cursor.



Character

Any single letter, number or symbol.



Read only

An option that means you cannot make changes to a file. You can change a file from being read only by 
using the Properties command in the Windows File Manager.



List box

A type of box that lists available choices, e.g. a list of font groups. If all the choices do not fit in the list 
box, a vertical scroll bar will appear down the right-hand edge of the list box.



Dialog box

A window that will appear temporarily to request information. For example, the Rename Group dialog 
box will appear for you to enter a new name for the selected font group.



Disk

A medium for storing information, e.g. the font groups that you create. Information stored on a disk 
remains there even when you turn your computer off, unlike information stored in memory.



Keyboard shortcut

A key or key combination that you press to carry out a command. If a menu command has a keyboard 
shortcut, the key combination is listed to the right of the command name on the menu. For example, 
pressing the keyboard shortcut F1 displays the help contents page.



Selection cursor

The marker that shows where you are in FontGroups and what you have selected. The selection cursor 
will appear as a highlight or as a dotted rectangle around text.




